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Win7/8/10 (64bit)
Windows Win7/\WinXP (32bit)
Windows Server 2008 R2

Centos6/7 (64bit)

Linux Ubuntul8.04 LTS
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2 BETE

TR AR 2 35 A0 D K T R license IRZS S 44 Gowin License

Server, 435 Windows FiAFT Linux fiiAs, 1@ B MR %
www.gowinsemi.cn/fag.aspx

Windows 4t T Iz IR 2B A RN “ ZIRERAT for

win(Vx.x.xBeta)”;

Linux 24t N =B E R4, A “ iR for
Linux(Vx.x.xBeta)”;

Windows &4t T HIEF 5.2 license IR55 A shik tE 2 A “ = WAl bk
4525 for Win”’;

Linux Z4¢ YT 8 license fij55 A s 2 R4 e, SR8 “w&
Z VP ATUEAR 55 &% for Linux”.

BAFTEGAT, R REME R
A A R4 4 FRVx.x.xBeta” H X" R R A I RRUA S
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http://www.gowinsemi.cn/faq.aspx

3 Hft e 3.1 Windows F 4t #f 4%

3 RHR%

3.1 Windows ARGt R %

Windows 4t I 12477 350 Wy IR AT 230, IRIEHR 7R 23,
oA R AR YE R B R H ok, REORE, 2 BOAE PC el
PREETT o

3.2 Linux R

TURBATAE Linux 288 N SCRFIS ISR ME R85 080 s
e, BRI 2k

3.3 HHREKIFEEN
3.3.1 Windows & &%
® HELURHAERT, BNSSH] 360, 4 il ol AL R F A
® IRAF B ERAR A SCRE B TR SCER TS AR I S B AR
3.3.2 Linux &A% &%
® Programmer )5 8 75 2% root BUIR ;
® (AL MERE, BUVEH “chmod” iy A& B0k 6 T $iAT SCAF I RLIR
3.3.3 SynplifyPro ;¥ EEIR
® RIFWM KR PC;
® RIHE 32 frifE R 45,
® Windows R4t LM R AGE 5 8 SynplifyPro, 15 1#H whatscl Ak
IER AT, Birm4d2%: \x.x\SynplifyPro\bin\whatscl.exe
--check-cert, 7 1 B, 15 BEFHE, B I R = = 34Kk FAE Ph B 58T
® Linux 24, #AlLE WAL E G217 SynplifyPro {358 M, $THF
Iroot/.bashrc S, R BMIEAL S LM_LICENSE_FILE, HAHM
XK “UH5@FNA", ZuidT source /root/.bashre J& B AT AE 2.
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3 A 3.4 W= 3

34 BHRZBR

Windows R4 %45 <RI, 78438 H % path\Gowin_Vx.x.xBeta
NEI% IDE. Programmer. SynplifyPro ()25 H 55 A %% 2 5 50 i al i
173X, il 3-1 FivR. Linux R4tz IR 223 H A #8= IRERAR
AfAT IO, HAH st (IDE. Programmer. SynplifyPro) 5 Windows
ARGMIE . AF L Windows 240 AN 8 2= R EE 2235 H 5% .

B 3-1 ZiRRHRERR
Mame Date modified Type Size
IDE 5/25/2020 5:39 PM File folder
Programrmer 5/25/2020 5:39 PM File folder
SynplifyPro 5/25/2020 5:39 PM File folder
€9 uninst.exe 5/25/2020 5:39 PM Application 99 KB

3.4.1 IDE REHZR

IDE S N =R 2225 H 5%, Wl 3-2 Fiow . bin SCHEIARTHAT
YAFH, 4 gw_ide.exe. floorplanner.exe 25 v $h47 3044, Xk
bin\gw_ide.exe T 88 = IR, X binVfloorplanner.exe R B2 )3 30
FloorPlanner. doc SRy i 3 A4 AH < B P 48 R S0« simlib ST R
IRBAE B, 1 EEME gwln. gw2a fll hardware_core.

[ 3-2 IDE B%

Mame Date modified Type
bin 5/25/2020 5:38 PM File folder
data 5/25/2020 5:39 PM File folder
doc 5/25/2020 5:39 PM File folder
ipcore 5/25/2020 5:39 PM File folder
plugins 5/25/2020 5:39 PM File folder
share 5/25/2020 5:39 PM File folder
simlib 5/25/2020 5:39 PM File folder

3.4.2 Programmer R H%

Programmer XN & i dmfEas <3 B, WK 3-3 fiss. bin
AN AT AT SO H 5%, X bin\programmer.exe 1] B 5 5 = TR 2
PR o
3-3 Programmer H3%

Mame Date modified Type
bin 5/25/2020 5:39 PM File folder
driver 5/25/2020 5:39 PM File folder

3.4.3 SynplifyPro 3% H%
SynplifyPro S 437y Synplify Pro #1235 H 3%, 4nf&l 3-4 flizs . bin
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3 Bt

3.4 B E

A R AT SO H 55, X bin\synplify_pro.exe A] B2 5 3l Synplify Pro

Bt doc SN Synplify Pro 84 AH 225 S0

3-4 SynplifyPro B

Mame Date modified Type
bin 5/25/2020 5:39 PN File folder
binfd 5/25/2020 5:39 PN File folder
doc 5/25/2020 3:39 PM  File folder
examples 5/25/2020 5:39 PN File folder
lib 5/25/2020 5:39 P File folder

3.4.4 uninst.exe

SUG501-1.0

uninst.exe, F1E = IRHAEI AT AT SO/, X uninst.exe, 5 Gowin
Vx.x.xBeta Uninstall #&/~x4E, #0&E 3-5 fin, s “Yes”, BIA[EIE =K

G
[# 3-5 REENEL

Gowin V1.9.6Beta Uninstall

Are you sure to remove Gowin Y1.9.6Beta and its all
components completely?

fes
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4 %44 License Bt & 4.1 License &>

4 B4 License Bt &

4.1 License &/}t

4.1.1 License X
BAF license & —Fiig &, HE=FShEHPZT, HUUEE R
B il A0 F P s A AR, DA = 2 SR N R A 55

At license EE AL A =2 license KA., 17 (MAC, Media Access
Control) Hudik. i FH HARE .

4.1.2 License &I

license 257, QHET A4 E R license(Node locked) F1iF £ 7Y
license(Floating).

FEBUE license, JERETANH L FT3RELA license, FRELTT &
i license A P R BEEBUE 1T b e LA B, HABHLES o AE
HiZ license.

17 R license, &R T1E RIS &Y license AR S5 28 40 BE L By
RELH) license, A H A EHEEIRS], WA &KKH A ERHEERS], ZH
WX AE—F P CGE R ARAD # AT LS .

4.1.3 License £

Windows #:1F %4t & Linux 1 % 4i 7] 18 Fif Node locked B Floating
[¥) license, license FLA&)fd AW~ Fridk:
1. AP HINE — G 5HUR PC, license Az 5 # #8225 481X G H1 28
b, W4, HPELMEH Node locked license, 7] LA# i Floating i

license;

2. ZAMHP B ZEH8IUR PC, B PC £ — R, &4 PC L
w7 mIRR A, A4, W LLHE Floating 1 license. Floating )
license ZIELE /I —& PC L, &ALt E#z:1% PC 17 IP 3%
B Floating license, #1& 4-1 ffizR.
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4 4% License BB

4.1 License f&j4

SUG501-1.0

& 4-1 B %85 & % Floating license

oh ER 5

ks

oL

Floating
License

Z M B 2 G 8L PC (irfy PC 272 windows #1F &40,

| H PC ER—A B, v L Floating [ license. £ windows fi

2R PEE RG0SR AT K Floating license, H1 77 7] LLZE H 2. PC
BB Chna m AR T A ) 17 ) windows R4, EEE %
windows Az %5 %85 F =R AE K license, 4K 4-2 Fiis.

ZAH P HIA £ & 5 4L PC (T PC #4572 windows #4t), ilif PC

| LE[E—AN R, AT PLHE Floating ¥ license. 7E linux #:1F &4t %

IR AE & Floating license, H P RTUALEHE C PC E&ESRIK T (40
i#id Exceed onDemand Desktop % /7 3% 5% ) Vi) linux RS o%, BEL#
I linux IR55 48 B IR+ ) license, W1 4-2 Ffiw.

ZANH P HIHA 2 G580 PC (BT PC 32 linux #E RS, A
PC fE[E—N Rk, v PLH i Floating [ license. 7E windows JR %5 %%
PR R G0 e 3B =P & Floating license, 7 7] LLE E &) PC
¢ (WniE RDP #h80) %) windows AR5 %%, B #E:d FiZ windows AR %%
IR K license, WK 4-2 iR .

ZAH P HIA 2 6 80 PC (BT PC ¥J72 linux &%), Fii PC 1L
[ —/N 3, BT LA E Floating f) license. 7E linux #1FE &4 L 3%
¥ J Floating license, H P T LAfE H &) PC _E(4nidiid VNC Sever)

Pila] linux RSS2, BERAE % linux RS 28 ER =55 I license, 1
4-2 s
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4 B fF License it & 4.1 License f&4r
& 4-2 fR 5548 %% Floating license X =R
=WRER
Floating License
4.1.4 YpEiE RIS
Windows 3kH MAC #7720 (BL Windows10 J94i)):
1. 797 “TFER” €8, ik#E “a iR fr”
2. TEMATRTEE O h%iN ipconfig/all, 4%[9] 4=
3. TEREIME BRI AT SREUE Hhhl, Wil 4-3 Z204E B S B TR
4-3 Win10 £4 MAC it
E¥ Command Prompt
8 Microsoft Corporation. All rights reserved.
jinfeng.GOWIN-ITC>i
(Preferred)
Linux 388 MAC Hitiki) 7520 (LA Centos7.5 Jyfii]):
1. ATF %
2. {ELIR¥ N “Isbinfifconfig”, f#%[E] %,
3. (ER[FEIFME BRI SRE A EE b, 40 4-4 Z0HE B RME B TR .
SUG501-1.0 8(25)




4 %4 License Bt & 4.1 License &4}

[ 4-4 Centos7.5 &% MAC #hit

[ruihua@JINAN9103 ~1% /sbin/ifconfig

eml Link encap:Ethernet |[HWaddr 98:90:96:A5:CC:0D|
inet addr:192.168.30.40 Bcast:192.168.30.255 Mask:255.255.255.0
inet6 addr: fe80::9a90:96ff:fea5:cc@d/64 Scope:Link
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
RX packets:6477545660 errors:0 dropped:0 overruns:0 frame:0
TX packets:9281832108 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:3098180390063 (2.8 TiB) TX bytes:8329690596305 (7.5 TiB)
Interrupt:20 Memory:f7c00000-f7c20000

lo Link encap:Local Loopback
inet addr:127.0.0.1 Mask:255.0.0.0
inet6 addr: ::1/128 Scope:Host
UP LOOPBACK RUNNING MTU:65536 Metric:1
RX packets:1279116809 errors:0 dropped:Q overruns:0 frame:0
TX packets:1279116809 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:0
RX bytes:14194406577155 (12.9 TiB) TX bytes:14194406577155 (12.9 TiB)

4.1.5 =R License ERiF

=R license AITE R = -SRI B W G BE @I B R FAE HEH
1, EMHEIFEHAE: http://www. gowinsemi. com. cn/faq view. aspx

HiE License BTN 4-5 Fim.
4-5 EMHE License T H

FRiSLicense

=IREEGRME 7 e anRit sl [ 8 |, RBiF oIS SRR FiHE =R iFa0ttEe.

gi5License

AEIBHR
AT
i
BEEARE:
BEARE
BE A RBAE:
BERASH: M
THEHMACHEAE:
licenses£8: Of44 Oft=8
EEESSE OWindows  Olinux
HEEEE (ReERT  (Bodidibs (OEReF CifsEss COEssn ORuasis (8

license Z5%. “fYANL” & Node locked license, “FL=#A1” 7 Floating
license.

H1iE 1) License {5 IR BRI —4F, i AR 205 T DL IR HR I
Floating license BRiASCHE 5 AN AT, WA B P A £ PR ).

SUG501-1.0 9(25)
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4 #4%: License Ft & 4.2 Windows ZEZ:# £ License it &

4.2 Windows ZZtE 4k License Bt B

Windows £ 41 license B & 77 :X—2, LA Windows10 £ 4t 41 i B o
4.2.1 SynplifyPro license HN#;

P a9 ER license (Node-locked)

T EAUER license /23 T AHL MAC Hudik 3R EL K license, (Y PRAS
LR P 8 . I3 SynplifyPro )7 4 &Y license J&, fic B A S AR & JI W],
BN “LM_LICENSE_FILE”, ZBRE N i 8 license %) #542
WK 4-6 Fios.

E 4-6 FHRTERE

Computer Name  Hardward Advanced  Fystem Protection  Remote

‘You must be logged on as an Administrator to make most of these changes.

User variables for gowinga

Variable Value
Path ChUsers\gowinga\AppDatatLocal\Microsoft\WindowsApps;
TEMP ChlUsers\gowinga\AppDataiLocal\Ternp
TP Ch\Usershgowinga\AppData\Lecal\Temp
Mew... Edit... Delete
New User Variable X
Variable name: | LM_LICENSE_FILE |
Variable value: | CAGowingowin.lic |
Browse File... oK Cancel
|
!

T R A L 2 2 R AR R synplifyPro Z54 L E, nlRg s I license oS in| i, FRAEIR
1545 & B RN SYNPLIFYPRO_LICENSE_TYPE, A synplifypro_gowin , & 4-7 i
& 4-7 7 SYNPLIFYPRO_LICENSE_TYPE

MNew User Variable

Variable name: | SYNPLIFYPRO_LICENSE_TYPE |
Variable value: | synplifypro_gowin |
Browse Directory... | Browse File.., 0K Cancel

SUG501-1.0 10(25)




4 #4%: License Ft &

4.2 Windows Z Zi % {4 License Bt &

SUG501-1.0

7258 license (Floating)

77 m A license BAERIEM NI E—E license IRS52%, RN PC
HETfE A . ¥ S license A F P AR R, HATH P &4 license 7l 77 22
Ja % license iR%S .

JashE SR license RS IR R

1. %% SCL ILH. fidixff¥ synplifyProLicenseStartServer [ 7] $447
A “scl_v2018.06_windows.exe” #t17 SCL B AF 1) %ed%, MRIEHA ;%
B GOP R AT 2, fEFRHY “Site Information” S AT A0 R EC
H:
® “Site ID”: 3K7H SynplifyPro [ license SC#F (U
gowin_synplifyPro.lic) ] “siteid” FUHUE, U1 29247;
®  “Site Administrator”: & AHLE FH 51 44K
® “Contact Information”: W ZEIHI, FH HBER TN
2. R4 SCL M2k m Sk B 22 35 8 4%, Inik #8845 C:\Synopsys\SCL”,
M b EEI B R LR A, 40 “ Completing the SCL 2018.06
Setup Wizard”, fidi “Finish” #4158 SCL %%,
3. 1&i% license SN2
® BUUTHENAH: license XHFHN%Z ‘SERVER hostnamel
F8BC12950972 27020" —4T, “hostnamel” & AN HHIL4
s “270207 yufi 145, AIARHE 2235 SynplifyPro it &EHLE ST
L@
® (B2 snpsimd #%4%: 4 SCL #44 snpsimd.exe HI#4E, Bk
license X% ‘VENDOR snpsimd /path/to/snpsimd’ —47. 0
E%CA: VENDOR snpsimd
C:\Synopsys\SCL\2018.06\win32\bin\snpsimd.exe-
4. n#; license XA
N4 license SCAFH PRI : SCL av AT H 5. SCL i fe B A
A3
® SCL 2475 3)
a). fIF cmd &, Eira4 a4l license k%, HATMS:
path\Imgrd.exe -c path\licensefile -I path\logfile
!
iy A R«
® -c: R license X f4;
® I frmEAERI log S
b). BT, BE log XXM (log X#4%: path\logfile), #hil
license »& 5 B3I, WA BRI, log U+ < LK 4-8
PR o

11(25)




4 B Mt License AiCE. 4.2 Windows Z e#i 1 License L&
[& 4-8 License &% LI log 3L
Gasewsevss woesiueus A Mool G sioaons 3 e e s
01/28/2019 09:16:06 (snpslmd) Siteid: 29247, Server Hpshid: 525400B8ABET, Issued on: 12/18/2018
01/28/2019 09:16:06 (snpslmd)
9:16:068 (sppslmd) SLOG: Statistics Log Fregquency is 240 minute(s).
9:16:06 (snpslmd) S5LOG: TS5 update poll interval is 0. TS update is detected by midnight reread only.
9:16:06 (snpslimd) SLOG: Activation borrow reclaim percentage is 0.
9:16:06 (gnpsimd) (Bsppslmd-SLOGE)
9:16:06 (gnpslmd) (@znpslmd-SLOGE) === Vendor Daemon ===
9:16:06 (gnrsimd) (Esnpslmd-SLOGE) Vendor daemon: gnpsimd
9:16:06 (znpslmd) (Bsnpslmd-SLOGE) Start-Date: Mon Jan 28 2019 08:16:06 CST
9:16:06 (gnpsimd) (Bsnpslmd-SLOGE) PID: 30659
9:16:06 (gopslmd) (Bsopslmd-SLOGR) VD Version: will.14.1.3 build 212549 x64 1lsb | build 212549 (ipvé))
9:16:06 (gnpsimd) (Bsppslmd-SLOGE)
9:16:06 (gnpslmd) (Bznnslmd-SLOGE) === Sgazrun/Restart Info ===
9:16:06 (gpRsimd) (Bsnpslmd-SLOGE) Options file used: NHone
9:16:06 (gnpslmd) (Bsnpslmd-SLOGE) Is vendor daemon a CVD: Yes
9:16:06 (gnraimd) (@znpslmd-SLOGE) Is TS accessed: No
9:16:06 (gpRsimd) (Esnpslmd-SLOGE) TS5 accessed for feature load: -NA&-
9:16:06 (gnpslmd) (Esnpslmd-SLOGE) Number of VD restarts since LS startup: O
9:16:06 (gnpalmd) (@znpslmd-SLOGE)
2:16:06 (gppsimd) (Esnpslmd-SLOGE) === Network Info ===
9:16:06 (gnpslmd) (Esnpslmd-SLOGE) Listening port: 37814
9:16:06 (gnrsimd) (Eznpslmd-SLOGE) Daemon select Limeowf (in seconds): 1
9:16:06 (gnpalmd) (B3npslmd-SLOGE)
9:16:06 (3npslmd) (Bsnpslmd-SLOGE) === Host Info ===
9:16:06 (gppslimd) (Gznpslmd-SLOGE) Host used in license file: gwlicenss
9:16:06 (snpslmd) (Esppslmd-S5LOGE) Running on Hypervisor: Not determined - treat as Physica].l
9:16:06 (sopslmd) (Bzppslmd-SLOGE)
e —
® SCL J e ERUE )
/ et S K7
a). ft snpsimd 42, EE 347304 Imtools.exe, Ft il 4-9
PR
4-9 SCL B&IFE
LMTOOLS by Flexera Software LLC - x
File Edit Mode Help
System Settings ] Ltilities ] Start/Stop/Reread ] Server Status ] Server Diags ] Corfig Services ] Baomrowing ]
Services allow FlexMet Servers to run in the background.
Server List
i~ Configuration using License File
¢ Configuration using Services
[~ LMTOOLS ignores license file path environment variables
No FLEXIm Services defined, use Configure Services to add services
N . . I N2 Y 5
b). #%F “Config Services” W2, &M CERRZE, Mk 4-10
Fis:
. N y
“Path to the Imgrd.exe file”: Imgrd.exe SCFFTE 42
. . . N 2,
“Path to the license file”: license S FT{E K42 ;
“Path to the debug log file”: 1%k license J&54E R[] log
/
AR
SUG501-1.0 12(25)




4 #4%: License Ft &

¥
76 log SCAE, BRI L log Ha i B —A log SCAE
E 4-10 SCL it BER |

4.2 Windows & % {4 License L &

LMTOOLS by Flexera Software LLC
File Edit Mode Help

— *

Service/License File I System Settings I Ltilities I Start/Stop/Reread | Server Status | Server Diags  Config Services | Bomowing I

Configure Service

Save Service |
Remave Service |

Service Name IFIexIrn Service 1 LI

Path to the Imgrd exe file I::‘\Smopsys\SC L%2018.06'win32%bin‘\Imgrd exe ﬂl

Path to the license file I.'in_license\gowin_smplif:.' Pro_64006a60f1bb lic ﬂl

Path to the debug log file |C:\ProgramData\FNP_DIF{\debug.log Browse | View LOg---l Cloze Log

[~ Start Server at Power Up

™ FlexNet Licensing Service Required

The HexMet Licensing Service is required for optional
features such as virtualization and trusted storage.

FlexMet Licensing Service is not installed or disabled.

c). BLE5E/E, Jashlicense fk%, WK 4-11 iR, E#

“Start/Stop/Reread” 7%, H.ifi “Start Server”, FI{ETJT
fi7n “Server Start Successful” MR E B3N Al @Ed#
F log XHAZE T B, Sdiinl& 4-10 (1) View Log A £

SUG501-1.0

F log X1F.
4-11 SCL [B&h license R

LMTOOLS by Flexera Software LLC
File Edit Mode Help

- X
Service/License File I System Settings | Utiities Start/Stop/Rersad | Server Status | Server Diags | Corfig Services | Bomowing |

FlexMet license services installed on this computer

Flexlm Service 1

Start Server | Stop Server ReRead License File

) . ™ Force Server Shutdown
e | NOTE: This box must be checked to shut down a license server

when licenses are bomowed.

|Using License File: C:\Synopsys*SCL\2018.06%\gowin_nerssa_syn_FL_50FAS4185130 lic

!
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4 #4%: License Ft & 4.2 Windows ZEZ:# £ License it &

JA B4 license %52 G, FIFEFRAECE RANTEZE LM_LICENSE_FILE 74 1] s Zh Nk
SynplifyPro % 557 license, ZF&E4 4y “LM_LICENSE_FILE”, A& N “W 15 @IP Hs
7, A 4-12 Fiose

E 412 M RTEZE

Computer Name  Hardware] Advanced [Bystem Protection Remote

You must be logged on as an Administrator to make most of these changes.

Performance
User variables for gowinga

Variable Value

Path Ch\Users\gowingalAppData\Local\Microsoft\WindowsApps;

TEMP ChUsers\gowinga\AppDatat\Local\Temp

TMP Ch\Users\gowinga\AppData\Local\Temp

MNew... Edit... Delete

Mew User Variable X
Variable name: | LM_LICENSE_FILE |
Variable value: | 27020@192.168.31.33 |

Browse Directory... Browse File... Cancel

4.2.2 Gowin license N

“IRBA G e G, AT IR BAERT &% license TR Y, W1AR
license ANIERf, AT B S IR Error #27-54E, W& 4-13 Fios. Ay
“OK” J&, #H license it & & 1, WK 4-14 Fion.
4-13 License Error }g7RIE

W Error >

License verification failed. please check your license configuration.
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4 #4%: License Ft &

4.2 Windows Z Zi % {4 License Bt &

SUG501-1.0

[#] 4-14 Manage License i%&IR

w License Configuration >
License Config
() Use Local License File (@) Use Floating License Server
Server: 192 168 . 31 . 246 Port: | 10559 Test Connection
Apply for License & i¥ License Cancel

P ER license (Node-locked)

F—IKACE license, A[#EK] 4-14 & Hi%#¢ “Use Local License File”,
PEA AT S8 E A license A, ¥y “Browse:s+”, INIISCAFIAEAE, H
o “Save” {RAFRIT],

WA A license BC &, A7E 2 YR 3K A T ) 5= |, Bd“ Help >

Manage License--”, # i “License Configuration” % [, 4nFd 4-14 fw,
R AT EE 5 license AL & .

728 license (Floating)

156 /# H PnrLicenseStartServer T H 8 zhi% ri M license Ak%%, mliEd

LR b7 5 30

1. HEXE “gwlic_serverexe” JHzl:
T EDF S license SCE (A gowin_license.lic) 2 il F)
“gwlic_server.exe” FIfERRIE T, #iF i license U4 N
“gowin.lic”, X “gwlic_server.exe”;

2. wATIEAE 3
17 ecmd & I, #4774 : path\gwlic_server.exe -I
path\gowin_license.lic -b. J& )5 @& 4-15 Fiw.

!

e -Iin# license 15

o -bFHIZ1T license k% -
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4 A% License Bt & 4.2 Windows Z Z &k {4 License it &

[# 4-15 Gowin Floating License Server S&IAH

BN Command Prompt - gwlic_server.exe -l gowin.lic -b - O d

IP Addres
Listening Port: :
> server started

BEhRIIZ JG, fE“License Configuration” % 194\ floating license
HR 554510 1P bk, 4nfEl 4-16 Fis.
4-16 Floating License A B A @

w License Configuration x
License Config
() Use Local License File (@) Use Floating License Server
Server: 152 . 168 . 31 . 295 Test Connection
Apply for License B i# License Cancel

AN “Test Connection” #5411 m] DL B8 75 F2 T, TN
21 License Configuration & I Hi ¥ “Success”, &l 4-17 iR,

SUG501-1.0 16(25)




4 #4%: License Ft &

4.2 Windows & % {4 License L &

SUG501-1.0

B 4-17 IR

4 License Configuration x

License Config

() Use Local License File (@) Use Floating License Server

Server: 192 . 68 . 31 . 294 Port: | 10539 Test Connection

Success

Apply for License & i¥ License Cancel

ANE MR R license ERLE BUEHT G, A HBI<H license Bt &
5 H5 N 2% 0 R IE B SCA\IDE\bin\gwlicense.ini H1, & 4-18 FioR.

4-18 License Ho &3 H
[ ewlicense iniEd I

1 [licen=e]
2 lie="192.168.31.246"™

E!

W B PR 22 55 B 3% F BIRCE S RRA 2, TBiE AT gwlicense.ini SCfF, i “Save”
PN 0 TCVEARAR IR . M R BEX gwlicense.ini Ui “Bek” 5 “BAN7

FORLER, BUA Skt @ M -> 2 &0, WK 4-19 iR, BURMBHJE, KT license
(L=
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4 #4%: License Ft & 4.2 Windows ZEZ:# £ License it &

B 4-19 STHBRIEK

gwlicense.ini Properties X

General Securty Details Previous Versions
Object name: G \gowinRelease Gowin_setup ' Gowin_V1.9.3.02|

Group or user names:

ER Athenticated Users
SF cvoTEn

t Administrators (SWEG-JINFENG \ Administrators)
SR Users (SWEG-JINFENG Users)

To change pemissions, click Edit. Edit

Permissions for Administrators Allow Deny

Full control
Modify |
Read & exscute
Read
I Write I

apecial permissions

For special permissions or advanced settings, Advanced
click Advanced.

Floating license FFHLHZNHZXE . L WIn10 R4 A% 4 anfif & &
Floating license FHLH 318 3l
1. #ERHEE A
HEALFR S 2571 start path\gwlic_server.exe -l path\gowin.lic —b,
AL AL B4 44 40 startFloatingLicense.bat.
2. KEAEALER S DL R B S0k
FIHEAT X EHE (win B+R), Fi A4 shell:startup, W& 4-20 fii7s.
%, K 4-21 s s, # startFloatingLicense.bat
Epa sty A NE AL
4-20 BT < shell:startup

4 Run x
=7 Type the name of a program, folder, document, or Internet
= resource, and Windows will open it for you,
Open: shell:startup w
QK Cancel Browse...
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4 #4%: License Ft & 4.3 Linux &%; license 2 &

B 4-21 BRI R
C:\Users\jinfeng. GOWIN-ITC, AppData\Reaming' Microsoft\Windows\5tart Menu\Programs\Startup

Fat

~ Mame Date modified Type Size

startFloatinglicense.bat  6/1/2020 2:33 PM  Windows Batch File 1t

3. BHEIHEBNEZHAHL
FIHESE A, W 4-22 Fizr, A% startFloatingLicense.bat 4
Enabled, Floating license F#1H 35 3h % & %I .

4-22 FHEER

1% Task Manager - O X

File Options  View

Processes Performance App history Startup  Users Details Services

Last BIOS time: 7.1 seconds

MName - Publisher Status Startup impact
B Intel® Graphics Command Center Startup Task INTEL CORP Disabled MNone A
|'|-- Realtek HD Audic Manager Realtek Semiconductor Enabled Low
| | startFloatinglicense.bat Enabled Mot measured
@ Waves MaxxAudio Service Application Waves Audio Ltd, Enabled Low
H; Windows Security notification icon Microsoft Corporation Enabled Low
WXDrive Tencent Enabled High h
Fewer details Dizable

4.3 Linux &% license Bt B
Linux 24 license it & /7 :0—%, LA Ubuntu 18.04 LTS M1t e .

4.3.1 SynplifyPro license 1%

Linux #8581 SynplifyPro R A7 s license. 1§ 2% DL B BRIAT
JIE=SuREF
1. %% SCL TH
Linux ¢ synplifyPro 3% £ license IR #iE & R4 AIER, % 5 1
I TR “synplifyProLicenseStartServer”,
2. &% license SXHENZ
® BIGHEN LR 41 AT license SCEHT, ¥4 SERVER hostnamel
000C293B1A2B 27020” H1 % hostnamel XN RS FHL4,
27020 Jyiii 145, RYE %3 SynplifyPro (it HLE BT 1B,
® {514 snpsimd #1%: 4R synplifyPro HEF A% license RS &b
snpsimd )12
(synplifyProLicenseStartServer/linux64/bin/snpsimd), ¥ license
Xt “VENDOR snpsimd /path/to/snpsimd” —47, & A
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4 #4%: License Ft & 4.3 Linux &%; license 2 &

snpsimd %1% .

3. Jn# license it
i synplifyPro F7% &7 license &5 844 N# license: 7E Imgrd SC14
FTfE# 12~ (synplifyProLicenseStartServer/linux64/bin) $47+8
4. /imgrd -c path/licensefile -I path/logfile, % log 344, &% log X
PRI SN, ), log SCAFH 2 HBLWE 4-8 Ak .
!
-c: f87E license X145
-l ¥R R log ST
4. MENFLE
o HTHHEH,, RENEAL S LM_LICENSE_FILE, TJf/etc/profile
S, XX RS E, HEREAN “uH s @ENA
U export LM_LICENSE_FILE=27020@gaoyun. & 5 vl Lhia
1T source /etc/profile, B{35 5 5 HN, (AR EAE R
® HTH4urHf, WEMNEARE LM_LICENSE_FILE, fT/HH I EH
Sk NH.bashre SO, TESCAFHREEAIAE AR R, AR “om 0
S@FHL4”, Wi export LM_LICENSE_FILE=27020@gaoyun. &
MO Ja AT LLZ AT source ~/.bashre, B # JE HK, {[FAEEEA
B
® T Huiin, BB RE LM_LICENSE_FILE, H%{F terminal
HIZAT export i 4 € AR AL &, HAE B AN o D 5 @ EHLA 7,
1 export LM_LICENSE_FILE=27020@gaoyun.
® license R, ERINKH 27020 i I, FH P AT HRAE S2 bR 75 SR 15
HUNAE E S
4.3.2 Gowin license hi#k

IR G e G, FT I IR 2% license TR A, WiR
license A IERf, AT B ShIFHRE Error 327~HE, WK 4-23 fin. M
“OK” J&, #H license BLE & 1, WK 4-24 Fion.

4-23 License Error &£ R~HE

e License verification failed. please check your licemse configuration.
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4 #4%: License Ft &

4.3 Linux &% license it &

SUG501-1.0

[#] 4-24 Manage License T

License Configuration x

License Config

Use Local License Fle @ Use Floating License Server

Server: | 192 . 168 . 30 . 40 Port: | 1055¢

Apply for License Wi License ‘ 9 Cancel

B Ea i ER license (Node-locked)

F—IKACHE license, W{EK 4-24 % Hi%k# “Use Local License File”,
PEAH e A license U, T “Browse-”, INIISCHRIESAE, B
“Save” LRAFRIT],
W PR license BL &, A 7E = PR FE S IS A L, Bdi“Help >
Manage License-+”, # i “License Configuration” & [, 1k 4-24 fR,
R w] 5535 license Mt & .

2R3 license (Floating)

B Je 4 H PnrLicenseStartServer T B B 5% 5 %Y license ARSs . Al
PLR PR 5 25 20
1. X “gwlic_server” JH#):
FE T SR license 3L gowin_license.lic) 5 1 #“ gwlic_server”
FTERIE T, 9% A7 license X% N “gowin.lic”, Xt
“gwlic_server”;
2. AT 3
T emd @10, $hrdr4: path\gwlic_server -l path\gowin.lic. JE3h/G
K 4-25 Fiox.
VE!
-l: Jn#k license 14
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4 #4%: License Ft & 4.3 Linux &%; license 2 &

[#l 4-25 Gowin Floating License Server BZIFAH

[jinfeng@jinan9015 lic server]$ ./gwlic server -1 gowin.lic
Dool Dool

==== GOWIN Floating License Server ====
==== Copyright (C) 2014-2020 GOWINSEMI ====

Oool Oool

18:46 = loading license...

tool: gowin, limit: 180, expired date: 2021-03-27
18:46 = starting server...

Host-id: 484D7EBC24D3

IP Address: 192.168.30.15

Listening Port: 18559
18:46 = server started successfully

BT 2 )5, fE“ License Configuration” & H Hh#i A\ floating license
R 5525 10 1P Hikik, Wi 4-26 Bk,

4-26 Floating License A& & @

License Configuration

License Config

Use Local License File @ Use Floating Licemse Server

Server: | 192 . 168 . 30 . 40 Port: | 1055¢

Apply for Li i Li ei: | 1541 5
pply for License Hiff License ‘ Cance H % Save ‘

il “Test Connection” #%4H AT LAIIIARE & BN, R RKT)
2=7F License Configuration & 1+ ¥ “Success”, WK 4-27 fizs.
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4 #4%: License Ft & 4.3 Linux &%; license 2 &
B 4-27 Wk ER
License Configuration x
License Config
Use Local License File @ Use Floating License Server

Server: | 192 . 168 . 30 . 40 Portz | 1055¢
Success

Apply for License Hif License ‘ 9 Cancel ‘ | % Save ‘

SUG501-1.0

ANE R RAN license fERCE BCHE BT 5, B H 32 license BLE
5 H5 N 2% 0 R IE B SCA\IDE\bin\gwlicense.ini H1, 1 4-28 FioR.
[&] 4-28 License Bt &3

¥. gwlicense.ini
File Edit Tools Syntax Buffers Window |

(=R =

1 [license]
2 1lie="192.168.30.

VE |
QR PR A2 25 H 3R IS B SO RURAS 2, Bk AR AT gwlicense.ini SCfF, H#.idi “ Save”
el S IR R IR . I R X gwlicense.ini SCHE AL “ BN BB, 7E
ZamHAT a2 “chmod +x <file>” Bi A& AEALIR .
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5 kR 5.1 Windows & % & 4 =5

5 N SY =

5.1 Windows & EBEh

PL Windows10 £ 4t il i .
5.1.1 GUI 2\ B3h

® XUtk a0 “EER”, WS B = YRt S
® ok A\ ‘73 H N\ X\IDE\bin”, XUl al $ AT “gw_ide.exe”;

® IJFcemd @A E M, A “%dE HE F\XXIDE\bin\gw_ide.exe”, Ul
“E:\Gowin\Gowin_V1.9.5Beta\IDE\bin\gw_ide.exe”;

® Xif TR 1 gprje
5.1.2 S 1TREN

£ emd fr A& H, HiA: path\IDE\bin\gw_sh.exe, {#ii A #4175
R, EAK tel fr £ W SUG100, Gowin =i #EFH P8R B % A

5.2 Linux RSB E

Pl Ubuntu 18.04 LTS Z&4: 1.

5.2.1 GUI XX 35}
® i “zdEH S F\WXIDE\bIn”, M i HAT 3 “gw_ide”.
® {f terminal iz #r4: path/x.x.xBeta/IDE/bin/gw_ide.
5.2.2 HSITIRBN

7t terminal i A\ f74: path/IDE/bin/gw_sh, 3 A fr 47 HIE =R,
HAK tel s 1EM SUG100, Gowin z R 7 8w K B 5% A
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6 BAFIR

6.1 Windows RS {HHE H

6.1 Windows RGEH BN

L PR 7 AGE A
® iy “File > Exit” &I,

® LTI A B KRR e

6.2 Linux R HRE

it PAR 5 2GR A
® Hiii “File > Exit” LI,

® iR A B EAR e,

SUG501-1.0
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